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Ta «Pathways» eival evotnteg pe tutorials Tou Unity ue GUYKEKPLUEVN BEUATLKA

Evapén

me development w

c

 +
@ learn.unity.com/pathway/unity
Movie:

@ Unity Learn My Learning  Pathways  Browse v Live

e > Pathways > Unity Essentials

Unity Essentials

New to Unity? This guided learning Pathway includes
everything you need to get started.

Continue Pathway Last visited on 9 Nov 2022

(® Overview - - 1Min51 Secs

Level Foundational
Pathway completion bonus +600 XP

Completion time 2 Weeks @

For Educators ¥

Content Outline

0/3 Missions completed

You can skip ahead to the ° Mission checkpoint to get
credit for the mission and earn a badge. You must pass all
mission checkpoints to earn the pathway badge.

SION
Get started with Unity

AN
V/\
(e

1 Hour 10 Mins

This mission will guide you from first install of the Unity
editor to creating your first Unity projects to play and
share with others.

@ Project: Start learning | 60 XP
@ Project: Start creating < 60 XP.

@ 9 Mission Checkpoint

SION
Explore Unity

https://learn.unity.com/pathway/unity-essentials



https://learn.unity.com/pathway/unity-essentials
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Foundations: Get started with Ur - X

c @& learn.unity.com/mission/real-time-creation-essentials?pathwayld=5f7bcab4edbc2a0023e9¢38f L %
Y. f 12|

14
AO l‘ln Communication 3C Movies onio Programming DNHost pOKN, EME Agukddog OIKOVOIK& Home Lan Media
You can "test out" of this mission by completing the mission
¢sessments. Scroll down and select Skip to mission checkpoint.

Choose content iV Srouf E E'Algn

Get started with Unity

4 Hours 25 Mins « +330 XP

Start creating

Project - Foundational - +60 XP - 2 Hours 55 Mins
k% (5754)

Start learning

Project - Foundational - +60 XP - 35 Mins
k% (9433)

Start organizing

Project - Foundational - +60 XP - 55 Mins
k% (7720)




< C @ learn.unity.com/tutorial/get-ready-for-unity-essent v=2020 3&projectid=612f9602edbc2alb588a3af3&mission.. & |12 W ’B » 0 2

@ Unity Learn My Learning Pathways Browse v Live For Educators v Q

&2 Join Pathway Discussion

Aopn
Tutorial

‘Ekdoon Unity (ta tutorials

; : : propouv va adopolv
BRI B0 nity Essentials Sladopeg ekO0ELG KaL VoL
* 2 elval mpooapuoopéva oe

2 Unity Technologies ,
OLUTEC)

Overview

Summary Select your Unity
g e tt version ©

Language
English

To Unity €xeL moAAEC ekbOoeLg. KaBe €kboon xapaktnpiletal and tov aplBuod tou €touc (2019, 2020, 2021) kat Tov avovta aplOud
umo-ékdoong my 2020.1, 2020.2, 2020.3. Kat k& umo-£kdoon £xeL 81k TNG avfovta aplOud pe eAdcooveg alhayEc/SlopBwoslg bugs
KATT, Ttx 2020.3.37, 2020.3.38 KATT.

Otav pla ékdoon «kAelos» kal 6 Ba umtapéel AAAN onuavTtiky uno-£kdoon , xapaktnpiletat cav LTS (Long Time Support) kat Ba
urnootnpiletal yla kamota xpovia arnod tn Unity pe evnuepwoelg/Stopbwoelg. My 2020.3 LTS



S Get ready for Unity Essentials - L' X Get Your Unity Pro Subscription = X

&

C & unity.com/pages/unity-pro-buy-now?ds_rl=1295837&gclid=CjwKCAiAvK2bBhB8EiwAZUbP1Fk_uPaPsj7RAITV5AHev G r % "ﬂ

Communication 3D Movies lonio Programming DNHost Mpoknpuésig EME Agukadag

Q Unity Products Solutions Learning More

GET STARTED ON

UNITY PRO

TODAY LW

Put our ecosystem of game creation tools, support, and community in your

team’s hands.

Get Unity Pro

Otkovopkda Home Lan Media
 Getstarted  Q

@ Create a Unity ID
3] signin

-,

*» 0O

Sch.gr

Anpwoupyoupe account
oto site tou Unity .

To account pag sivat
ONUAVTLKO KOOwWG
anatteitat yla tnv
gykataotaon tou Unity.
To eykateotnuévo Unity
TIOU €XOULE OTOV
UTTOAOYLOTH MOG
ouvbEetal e To account
HOG KoL TtpoocapoleTal
oTnVv adela xprong mou
€XOULE.

ErtumA€ov O,TL ayopEG
KAvVoupE armo to Market
Store tou Unity,
ouvdéovtal UE TO
account pag Ko
UITOPOUE VAL TLC
XPNOLUOTIOL GOV UE (per
seat licence).
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Projects

NAME

Alew Unity Projyct

- [m]

New project

Projects tab

In Unity, you will work in multiple projects, just like you work in
multiple documents using office applications, or multiple images using
graphics software. The Projects tab is where you’ll create and import
new projects and manage existing ones.

Learn tab

The Learn tab is your instant connection to resources for learning
Unity. Check the Learn tab for featured learning experiences and
tutorials on specific skills.

Community tab
The Community tab is a quick reference resource that lists various
places you can engage and connect with the wider Unity community.

Installs tab

You’ll be installing new versions of Unity as the engine evolves. The
Installs tab is where you’ll manage and configure these installs in the
Hub.

Hub preferences and account settings

There are two additional controls on the Hub’s main screen:

1. Selecting the settings (gear icon) opens your Preference settings for
the Unity Hub.

2. Selecting your initials opens an account menu for your Unity ID.



Adou dnuloupyriooupe account oto site tou Unity katefalouvpe mpwta to Unity
HUB. Eival to «k€vtpo eAéyxou» tou Unity arm’ omou Staxelpl{OHaoTE TG EKOOTELC
TIOU €XOULE EYKOTAOTHOEL KoL Ta Porject pac.

Installs Locate Install Editor

Installs

] 2020.3.40f1 s

@ 200323 us . To Unity éxet moMég ekdbooelg. KabBe £xkdoon
xapoaktnpiletatl and tov aplbud tou €toug (2019, 2020,
2021) kat Tov avfovta aplBud umo-ékdoong my 2020.1,
2020.2, 2020.3. Kat kaBe umo-ékdoon €xeL SIKO NG
avgovta aplOuo pe eAdoooveg arayeg/Slopbwoelg bugs
KAm, iy 2020.3.37, 2020.3.38 kAt .

] 2020.3.22f1 urs

Otav pla €kdoon «kheiosw» kot &g Ba umdapéel AN
onNUAvVTIKR umo-£kdoon , xapaktnpiletal cav LTS (Long
Time Support) kot Ba unootnpiletal yla Kamola xpovia
arnod tn Unity pe evnuepwoelg/dlopbwoelg. My 2020.3 LTS

MNatwvtag oto «Installs» PAémoupe TG ekdooelg tou Unity Editor mou €xoupe
EYKOTECTNUEVEG OTOV UTIOAOYLOTH HOG. MmopoUpe va €XOUpE TIOAAEG €KOOOELG KOOWG
Sladopetika pag Projects umopel va €xouv dtiaxtel pe Stadopetikeg ekdooelg. MNa ta
Project pag kaAo eival va xpnolgomnolovpe LTS ekdooelg tou Unity kot tnv mio mpoéodatn
€kboon Tou UTOoTNPLEL T XOPAKTNPLOTIKA Tou Project pag kot Tuxov SKDs mou B€éAoupe
Va XPNOLUOTIOL)COUUE



Matwvtag oto «projects» BAEnoupe TN Alota pe ta Porject pag. KaBe Project €xel to 61ko tou folder oto okAnpo pog dioko.

o P rOje cts v New project

Byron_Game_RTS_2020_VR_Oculus

ARMap
F

TestAR

Byron_Game_RTS_2020_VR_PC

Byron_Game_RTS_2020
Byron_Game_RTS_2020_WEB

TestVR2

‘Ekboon tou Unity Editor pe tnv omola epyaldopocte oto Project. MmopoUue va
emAé§oupe va avoifoupe éva Project pe diadopetikr) €kSoon amod auth TOU TO
' . SouAevape (my yia va to avapaduicovupe oe veotepn £€kdoon tou Unity Editor).
Alota Twv PI"OjeCtS Xpewaletar Opwg oAU mpoooxn kKabwg to Unity Ba petatpédel ta otolyeia tou
Project pag otn véa €k6oon Kol KAMOLO TPAYHATA MMOPEL va pn SoulAelouv.
NANTOTE naipvoupe éva backup to folder tou Project pag npwv aAAd§oupe ékdoon

Unity Editor oto Project wote av XpELAOTEL VoL LITOPOUUE Va TO EMAVAPEPOULE.



& unity Learn
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Q unity Documentation @ unity Microgames



Insta”s Locate Install Editor

MmnopoUue ©€ Ll Umdpxouoa
EYKOTAOTAON  va  TPOCOETOUNE
Modules mou &ev eixape emAéEel

otnvV  apxXWKn  eykatactacn - (my
@ 20203280 s : urnootnplen Android)

Installs

] 2020.3.40f1 s

& 2020.3.22f1 11

‘Add modules for Unity 2020.3.40f1 s

Add modules v 608.69 GB



Zekwvwvtag €va véo Project to Unity HUB pag mpoteivel pla oslpd and Templates mou pUmopoU e va XpNOLLOTIOL)COUE yLa Vol
dtaéoupe tn Baon tou Project. Avadoya pe To €ib0o¢ tou Porject StaAéyoupe To Lo cuvadég template wote va priaxtel Eva véo
Project pe Baoikn Asttoupykotnta nmou Ba xpelaotel oto €idog NG epapuoyng Mou avantUCCOUE

‘Exkdoon tou Unity
. Editor mou Ba
- 20203400 s xpnotpomnownei

= All templates

S L L NN

Template ywa to
3D Sample Scene (HDRP) : ; BQO'LK(I) KOp u(') ™ng
edappoyng

3D Sample Scene (URP)

Ovopa tou Porject
My project

3D Mobile D:\Unity

Folder oto onolo
Ba dnuoupynBetl
To subfolder tou
Porject

2D Mobile

First Person

Cancel Create project

Templates are “starter” Unity projects in various formats, with preselected settings and feature sets based on common best
practices. Some templates even include sample projects and tutorials, such as the Microgame templates you might have
encountered the first time you installed Unity. Each version of Unity has its set of templates.



Otav ¢priaytel to véo Porject avoiyel to Unity Editor. H Aldtagn twv mapabupwv pnopel va dtapopdpwOel amnod tov xpnotn

s GameObject Compo ow Help
AEIEEIEl EEDET B
= Hierarchy ai

dhe

 Scene
Shaded

@ AssetStore = Animator

ST ER % | mu~ | Gizmos | v | o Display 1 ~|1820x1080 v Scale @ 0.7x

v € SampleScene
) Main Camera
£ Directional Light

Statistics
Audio:
Level: -74.8 dB
Clipping: 0.0%

Graphics: 5.2FPS (193.9ms)
CPU: main 183.9ms rander thread 0.2ms
Batches:2  Saved by batching: O
Tiis: 1.7k
Screen: 19201080 - 23.7 MB
SetPass calls: 2 Shadaw casters: 0
Visible skinned meshes: 0
Animation components playing: 0
Animator components playing: O

DSP lnad: 0.2%
Stream load: 0.0%

= Project a:
S 8o x|®0
» * Favorites Assets
T ™ Scenes

I Scenes

» M Packages

Bconsole @ Animation | H Timeline
Preview [1ea | 14| > | bl o [»] O

® || & | account ~ [ Layers

= J Layout

i | @ inspector
Maximize On Play B Stats Gizmos |~

Te timeline, selecta

g
|

Tutorial yia tnv e€owkelwon pe tov Editor

https://learn.unity.com/tutorial/explore-the-unity-editor-1#6124ecdcedbc2a54df07500f
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< Essentials Project - SampleScene - PC, Mac & Linux Standalone - Unity 2020.3.40f1 <DX11>

File Edit Assets GameObject Component Window Help

@ | % || Frivot | @Global

it Scene

Set Active Scene

£ Main Came

7 Directional Save Scene
Save Scene As
Save All
Unload Scene
Remove Scene
Discard changes
Select Scene Asset
Add New Scene

GameObject Create Empty

3D Object > Cube
Effects > Sphere
Light > Capsule
Audio > Cylinder
Video > Plane
ul > Quad

Text - TextMeshPro
Ragdoll...
Terrain

Camera

M Project

+v [

» = Favorites ‘ Assets
B Scenes

Tree
Wind Zone
3D Text

s Scenes
» Bm Packages

To create a cube primitive in the Scene, right-click an
empty section in the Hierarchy and select 3D Object >

Cube.

The GameObject named Cube now appears in the
Hierarchy, and a Cube appears in the Scene view.

achy [ A

ar Al

< SampleScene*

fr) Main Camera

£7) Directional Light



Me ta epyadeia Move, Rotate kat Scale Mmopoupe va aAAGloupe tn B€on , TNV nmeplotpodn Kot To PEYEOOG TOU aVTIKELUEVOU. To
1610 pmopoupe vy kavou e divovtag TIEG OTa avTioTola properties tou avtikelpévou (Transform Component)

& Y rccount -

O Inspector

< Essentials P!

File BPbject Component Window Help

- O3

act - SampleScene - PC, Mac & Linux Standalone - Unity 2020.3.40f1* <DX11>

8 | Cube ~ Staticv

T Tag Untagged v | Layer Default M
# Scene ] -+
552 Shaded % | ®t~ | Gizmos [v | o Al v ). Transform 9 3 :
v € SampleScene* H Position X0 YO0 Z0
71 Main Camera n
) Directional Light Rotation X0 Y 0 Z0
) Cube i Scale X1 i 211
v B cube (MeshFilter) [ =L
Mesh i Cube (0]
v B8 v Mesh Renderer e i
» Materials 1
» Lighting
» Probes
» Additional Settings
¥ & v Box Collider e 3
Edit Collider
Is Trigger [ |
Material None (Physic Material) ®
Center X0 YO0 Z0
Size X1 Y1 21
I Project
k=l Default-Material (Material) Q
»  Favorites
> Shader Standard ~ | Edit...
M Scenes

» Im Packages Add Component




Packages are small collections of Unity features

or assets that help you do different things in

your projects. This includes both:

e Core features of Unity, that are installed by
default alongside the Editor

* Additional packages, that you can install in a
project when you need them

Packaging different features together reduces
the initial download size and time required to
install a Unity version, and means that you can
customize the Editor to meet the specific
needs of your projects.

You can manage the packages in the Unity
Editor using the Package Manager window.
You can also view Asset Store packages you
have downloaded or installed there.

ne - PC, Mac & Linux Standalone - Unity 2020.3.40f1 <DX11>

Component Window Help

Panels >

Next Window Ctrl+Tab

@ Asset
Previous Window Ctrl+Shift+Tab 7

>

Layouts

Collaborate
Plastic SCM

Asset Store
Package Manager

Asset Management
TextMeshPro

General
Rendering
Animation
Audio
Sequencing
Analysis

Al

Ul Toolkit

a

(5|6 *|m0



Mnyn npogAevong tou Package
o

20 Animation

| Perfect

= Package Manager

v Ur Unity Registry
Ji ¥ InProject

»T My Assets

» T Built-in

» Timeline

» Unity Ul

2D Animation

Unity Techno 5

Version 5.0.6 - June 16, =

nimati
al anim

Registry

+ ~ | Packages: In Project v | Sort: Name + v

y tooling and runtime

3.0.15 @

11.31 @
3.06 v

1.4.8 v

:omponents fo

JetBrains Rider E

Unity Technologies
Version 3.0.15 - June 21, 2
com.unity.ide.rider

View documentation . Viev

The JetBrains Rider Editor p



Ertidéyovtac « My Assets» Mrmniopoupe va doupe kat Packages mou €xoupe dtaBeoiua
amo 1o Unity Asset Store kal va ta eLodyoupe oto Project pac.

lMNa kaBe Package €xoupe
T duvatdtnta va To
KateBAaocoupe (av dev To
€XOUE KaTtePAoEL MOTE) ,
V0L TO ELOAYOUE OTO
Project ka va To KAVOUUE
Update.




Méoa amnod to Hierarchy pmopoupe va
SLaxelpl{OMOOTE TO AVTIKELMEVA TNG

W_*Scene
+ > oAl Shaded v | @l 2|y

@ SampleScene*  : A
B oknvic.
Directional Light
Co, ] ’
i MrmopoUlE yLa Topadelypa va
Rt KOATOLOKEUAOOUUE pUlo odaipa mou va
Duplicate ! ’ !
S OVNKEL OTOV KUBO TTOU ELXAME TTPLV
Select Children npoocBeoeL
Select Prefab Root
Create Empty
3D Object > Cube
2D Object > Sphere
Effects > Capsule = Hierarchy _
Light > Cylinder 4~ |o Al
Audio > Plane v € SampleScene*
Video > Quad ] Main Camera
ul > Text - TextMeshPro Fr) Directional Light
Camera Ragdoll... b E Cube
Terrain
Tree
Wind Zone
3D Text




‘= Hierarchy a2 i

+ = [a ol
v € SampleScene*
) Main Camera

Directional Light
¥ 7] Cube

m

MrmopoUE va LETOKLVI)OOUME T odaipa wote va
daivetal otn oknvn.

KaBwc n odaipa Lepapykd avikel otov KUBo,
LETAKLVWVTOC, TtepLloTpEPovTac i aAAdlovtog peyebocg
otov KUBo , Ba akoAouBel kal n odaipa

Av B€houpe va Byaloupe tn odaipa EKTOC
KUBou otnVv Llepapyiol LTOPoUE VAL TNV
kKAavoupe drag oto Hierarchy mapdBupo



QWEIRTY

v Bl

Q: Hand tool, to pan your view

W: Move tool, to select and change position
E: Rotate tool, to select and rotate

R: Scale tool, to select and change size

T: Rect Transform tool, to scale in 2D

Y: Transform tool, to move, scale, and rotate
with one Gizmo

For each of the transform tools, a Gizmo
appears that allows you to manipulate the
GameObject along each specific axis. As you
manipulate these controls, the values in the
Transform Component change accordingly.




Scone view navigation Liseful shortcuts

Tl lzon | Shiortout Purposc
ﬁ} W | Hand Tool ._ﬂ G Move your Scene around in the
] : windoa
6 | A I S III b | Maowve Tool E L Selact ibems and move them
{!’ ndividually
Fotale | E Sedes] iz ardd rotaie them
- o
Sclect a GameDbject | Leftdick te GameObject real —
Ity SCAT View Scale Tool = | R Scale your GameDbects up and
diran
Mowve the Scene view | Middie-cick and drag i wour
i desired view Rect —m T bMove, ratate, or scale 20
Transform | /== Gamelbjects or Ul
Rotate the Scene wiew | Right-chck and drag 1o your Toal
[
camera desirad view Rotate, E ¥ Maove, ratale, or scake 30D
Kove or Gamelbjests
Ecalke




2.Create an empty GameObject

An empty GameObject is a placeholder object that can be created in the Hierarchy. It does not have a
visible representation in the Scene, and it can act as a container for other GameObjects.

2. Rename this GameObject to Monument in the Inspector.

Rename
Duplicate
Delete

Select Children
Select Prefab Root

 CresteEmpty 3. Select this new GameObject in the Scene view. In the Inspector,
3D Object reset the position by selecting the three dots on the right and then
2D Object selecting Reset Position. This sets the position of the center of the

Effects GameObject to 0,0,0, aligning it to the center of your Scene.
Light

Audio
Video
Ul

[ |
Default -

o 3

Reset

Mave to Frent

Move to Back

Copy Component
Paste Component As New

Paste Component Values

1. Right-click in the Hierarchy and select
Find References In Scene

Create Empty. e

Reset Rotation
Reset Scale




# Scene W AssetStore ™ Animator i Timeline i
Shaded v/ |20 || @ |m) | || B0 B |~ % | W > |Gizmos | v | o All

Tools
Mo custom tools available




3. Right-click on the Floor GameObject and select
Duplicate. (Shortcut: select Floor and press Ctrl-D.)
Duplicate Floor six more times so that you have the
original Floor and seven duplicates, for a total of eight

1. In the Hierarchy, right-click the Monument GameObject
and select 3D Object > Cube to create a new cube as a child
of Monument.

f_““"a'?'l i BT  scene  [liAsset floors that are children of Monument.
v (a/ Shaded v
v € SampleScene* 3 — .
TR = Hierarchy | 3 i
€71 Directional Light + = |a Al
= S v € SampleScene*
Paste 71 Main Camera
pan 71 Directional Light
Duplicate v @ Monument
Delete @ Floor
R £ Floor (1)
Select Children
B £ Floor (2)
Select Prefab Root
£ Floor (3)
Create-Fmpty @ Floor {4]
3D Obje(t > Cube @ Flmr {5]
2D Object > Sphere @ Flaar {'B]
Effects > Capsule I"‘“’1 :
, i Fr) Floar (7)
Light > Cylinder
Audio > Plane
Video > Quad
ul > Text - TextMeshPro
Camera Ragdoll...
Terrain
Tree
Wind Zone
2. Rename this new GameObiject to Floor.
= Hierarchy | (=
4+~ [o Al |
v € SampleScene* ; 3.Create the steps
) Main Camera

7 Directional Light
¥ (71 Monument




4.Transform the steps

the values indicated below.
1. Select the first Floor child object and change the

Transform Component values in the Inspector as shown Values for Floor (1) GameObject

2. Do the same for the rest of the Floor objects using

below.
_ v ). Transform e 3t
© Inspector | B Mavigation =0
Paosition x 0 ¥ 0.2 i
@ | Floor Static ¥
~ Tag Untagged ~  Layer Default - Rotation X0 Y 0 £ 0
¥ A Transform @ i+ Scale X 18 ¥ 0.2 £(18
Position X 0 Y 0 Z0
Rotation X0 Y 0 Z 0 .
Values for Floor (2) GameObject
Scale % 20 Y 0.2 z[20 ] 2) J
¥ ) Transform e 3
FPosition x 0 ¥ 0.4
Rotation x 0 ¥ |0 L0
Scale X 16 ¥ 0.2 £ 16
Values for Floor (3) GameObject
v N Transform 9
Pasition x 0 Y 0.6 il
Rotation x 0 Y0 Z0
Scale X 14 Y 0.2 £ 14




Values for Floor (4) GameObject

v ) Transform e 3t
Position X0 ¥ 0.8 Z0
Rotation X0 ¥ 0 0
Scale X 12 ¥ 0.2 £12

Values for Floor (5) GameObject

v ). Transform o
Position X 0 vh Jzo
Rotation X 0 Y 0 Z0 Focr @asetsun | a3 Trars
Scale X 10 Y 0.2 Z 10

Values for Floor (6) GameObject

v ) Transform e 3
Pasition X0 Y 1.2 Z0
Rotation X0 ¥ 0 £ 0
Scale X8 ¥ 0.2 £ 8

Values for Floor (7) GameObject

¥ ) Transform [ 7 il
Position x 0 (1.4 £(0
Rotation x 0 ¥ 0 £ 0

Scale X B (0.2 Z e




5.Create the walls

1. Create another Cube primitive as a child of the
Monument GameObject and rename it to Wall.

EHearchy [ A&
+ > oAl
v € SampleScene* H )

7 Main Camera e IO TS IR 0 CoEo
7 Directional Light

¥ 7 Monument

0 Flaor (7)

0 Floor (6)

0 Flaor (5)

0 Flaor (4)

0 Flaor (3)

0 Floor (2)

0 Floor (1)

1) Floor

m

2. Change the values in the Inspector as shown below.

¥ M Transform e
Pasition X -6.5 X5 £ -6.5
Rotation X 0 ¥ |45 £|0

Scale X(0.2 ¥ (10 Z[10




3. Duplicate the wall three times and change the Transform Wall (1) GameObject
Component values as shown below.

¥ ) Transform e
= Hierarchy 2 i Position X 6.5 Y 5 Z 65
+- ;5'5” — : Rotation X 0 Y 45 Z0
v amp cene H
& Main Gamera Scale X 0.2 Y 10 210
7 Directional Light
v E’%i’?““{;; Wall (2) GameObject
o0r
71 Floor (6) v ) Transform 8 i
gi:mr 5«]1 Position X 6.5 Y5 ? 65
o0r
& Floor (3) Rotation X 0 Y -45 Z 0
£ Floor {2) Scale X 0.2 Y 10 Z 10
£ Floor (1)
7 Floor
) Wall .
2 Wall (1) Wall (3) GameObject
7 Wall (2)
0 Wall (3) v M Transform e i
Pasitian X -65 X5 £1|6.5
Rotation X 0 ¥ -45 £|0
Scale X 0.2 ¥ 10 £10

# Scene | @l AssetStore i+ Animator  Ef Timeline.
Shaded M




6.Create the roof

1. Create a new empty GameObject as a child of the Monument
GameObject and name it Platform.

= Hierarchy [

4+~ ol
¥ € SampleScene*
7 Main Camera
7 Directional Light
¥ 7 Moenument
£ Floor
€7 Floor (1)
E0 Floor (2)
£0 Floor (3)
£0 Floor (4)
£0 Floor (5)
£ Floor (8)
(0 Floor (7)
1 Wall
£ Wall (1)
7 Wall (2)

S VNTIE | —
£ Platform

2. Drag all the floor objects into the Platform GameObject. This creates
what is called a nested GameObject, in which objects are nested at
multiple levels as children of one GameObject. In this case, the
Monument GameObject is the parent, and all the Floor GameObjects
are its children. When you group objects together like this, you can
manipulate them all together and make copies of the whole group
while still maintaining the relationships between them.

= Hierarchy CEHearchy | @i
++ (oAl 4+ o Al
v <] SampleScene* = v € SampleScene* H
) Main Camera ff) Main Camera
f7) Directional Light f0) Directional Light
¥ (1) Monument ¥ (7 Monument

& Wall

& Wall (1)
5 Wall (2)
5 Wall (3)
¥ (7] Platform
A Floor
&2 Floor (1)
£ Floor {2)
£ Floor (3)
£ Floor (4)

&

G Fl

7 Wall (1)
7 Wall (2)
7 Wall (3)
71 Platform

&0 Floor (5)
71 Floor (8)
E0 Floor (7)




3. Duplicate the Platform GameObject. The duplicate Platform will
include duplicate child objects. Rename this copy of Platform to Roof.

4. Select the Roof and use the Move and Rotate tools to put the roof
onto the structure. Try positioning the Roof in the Scene view without
changing the numbers in the Transform Component, but when you are
done, the numbers should look like the ones shown below.

# Scene | Wl AssetStore Animator i Timeline
L] | % | w1~ |Gizmos |~ | [ Al

© Inspector | 32 Navigation 2 i

8 ~ | Roof | Static~
7 Tag Untagged ~ | Layer Default -

v A Transform

¥ 10
Y 0
Y1

Position

Rotation

Scale



Add components to 3D GameObjects

Summary
In this tutorial, you will see how components add functionality to GameObjects.
The component you will see in action here, the RigidBody Component, lets a
GameObject behave like a physical object instead of floating in space. In this
tutorial, you will:

*Position the Main Camera to display action in the Game view.

*Explore the relationship between GameObjects and components.

|ldentify specific components in the Inspector window.

*Add physical properties to a 3D GameObject by applying the RigidBody

component and setting its properties.

*Enter Play mode to preview a Scene in the Game view.

*Experiment with 3D physics in Unity.



1. Create a new Sphere GameObiject in the Hierarchy.

= Hierarchy | 8 ] # scene
4+~ [ nl

v < Untitled
£ Main Camera

e 2. Move the sphere to the space inside the Monument, so that it is

positioned in “mid-air” above the steps. You can use the Transform

c tools, the Transform Component in the Inspector, or both.
opy

Paste

Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty

3D Object > Cube

20 Object > Sphere

Effects > Capsule

Light > Cylinder

Audio > Plane

Video » Quad

Ul » Text - TextMeshPro
Camera Ragdoll...

Terrain

Tree




3.Position the Main Camera

In every new Scene, there is a camera like the one shown below.

This camera, named Main Camera in the Hierarchy, captures and displays your Scene to the player as it appears in the Game
view. While the Scene view is where you build Scenes, the Game view is a preview of the way your game appears to the player.
The camera in your Scene is a GameObject like any other. When you select it, you will see its Transform Component in the
Inspector window. You can change these settings as you would with any other GameObject. Note that scaling a camera will have
no effect.

When you select a camera, you see the outlines of a pyramid-like shape called the frustum. The frustum shows you what part of
your Scene the camera is viewing. Anything outside the frustum is not visible to the cdmera.

# Scene @ AssetStore ™ Animator - Timeline i
Shaded v|(20 || ® |w) | |~ 0 |Hy |~ %m0~ (Gizmodl| v | o Al

Camera Preview




When a camera is selected (1), you can expand the Camera Component in the Inspector (2) to open a Camera
Preview window (3) that shows you what is visible to the camera in the Scene.

# Scene | W AssetStore Animator £ Timeline i | ©Inspector | X Navigation o
- @ ||t |v - % - Gi v|[a A
Shaded 20 || @ | |2 |v| 950 |HY ¥ | Bt~ | Gizmos @ 7 TR T
" Tag MainCamera > Layer Default v
v /. Transform e i
Position X 0 Y1 Z -10
Rotation X 0 Y 0 Z0
Scale X1 1 1
v Bt v Camera 9 @ i+ @
Clear Flags Skybox -
Background I
Culling Mask Everything -
Projection Perspective v
FOV Axis Vertical v
Field of View ® 60

Physical Camera

Clipping Planes Near 0.3
Far 1000
Camera Preview Viewport Rect X0 Y0
W1 H1
Depth -1
Rendering Path Use Graphics Settings -
Target Texture None (Render Texture) ®
Occlusion Culling v
HNR Llse Granhics Settinas -

Move the camera to a position where it can “see” the ball and the steps below it.
Tip: You can also move the camera to align with your current scene view by selecting it in the Hierarchy window
and then pressing Ctrl+Shift+F.

Select the play button to run the game. Notice that nothing is happening at the moment. This is because you still need to
apply a component to the sphere to tell it how it needs to interact with the physics of the game. In this case, you need to
make it solid so that it reacts to gravity.



4.Make the sphere solid

in a Unity Scene, by default, GameObjects don’t have mass or respond to gravity. To make a GameObject behave like a real-
world physical object, you can give it physical properties by adding a RigidBody Component.

To add the RigidBody Component to the Sphere GameObiject:
1. In the Hierarchy window, select the Sphere. Add Component
2. Select the Add Component button in the Inspector window.

v & - Sphere Collider @ 3
Edit Collider e
Is Trigger
3. Use the search bar to find a Rigidbody component and select it. Material None (Physic Material) ®
Note that there are two options available, Rigidbody and Rigidbody ze;‘” (argd L
adius
2D. Make sure you select the Rigidbody component, not the 2D one. ———————— Search ——
Detaut-a ~C
» Shader Stan @3 Rigidbody 2D
1 Wew seript >
4. In the RigidBody Component in the Inspector, select Use Gravity if it
is not already selected.
v &  Rigidbody o 3
Mass 1
Drag 0
Angular Drag 0.05 _ _
Use Gravity o
Is Kinematic
Interpolate None -
Collision Detection Discrete -
P Constraints 5. To see the effect of these properties, start the game by pressing the
¥ Info Play button, which will display the Game view.
e ’ he ball falls and rolls down the steps. If it d t roll, t ing it
S 0 n n The ball falls and rolls down the steps. If it does not roll, try moving i

to a new position using the transform tools and run the game again.




5.Experiment with falling GameObjects

Try variations of this exercise. Move the Sphere GameObject and the Main Camera to get the results
you want.

More things to try:
* Add more spheres with RigidBody Components at varying heights.
* Add other primitives and see how they behave.
* Drop objects in different places.
* Rotate the Monument GameObject.

One thing to note is that you can change the properties, values and position of a selected GameObject
while the game is running, but when the game is stopped all values will revert back to what they were
before the game was started. This is useful to test different parameters during runtime, but if you want
the changes to be permanent, you need to make the changes while the game is stopped.



Create effects for 3D GameObjects

Summary
In this tutorial, you’ll explore some visual and
physical effects you can achieve in a 3D Scene.

You will:

*Create and configure a new Material to add
visual properties to a GameObject.

*Create and configure a Physic Material to add
physical properties to a GameObject.

*Configure the directional light.

Materials
Herringbone Brick baseColor.png



https://connect-prd-cdn.unity.com/20201001/26e9117a-554a-406c-824e-a4fa4e649738/Herringbone_Brick_baseColor.png

1.0verview

Materials are components that define the surface characteristics of objects, and how those surfaces interact with light. In each new
3D Scene, directional light is included to simulate the sun. In this tutorial, you will create a simple Material to change the visual
appearance of a GameObject, and use a Material to change physical properties as well. The directional light will bounce off the
GameObject with its Material to create a visually realistic effect.

2.Before you begin

The visual appearance of the Material will come from an image file. You can download the file used in the steps below,
Herringbone_Brick baseColor.png,

Materials
Herringbone Brick baseColor.png



https://connect-prd-cdn.unity.com/20201001/26e9117a-554a-406c-824e-a4fa4e649738/Herringbone_Brick_baseColor.png

3.Import an image file

1. To make your Unity windows match the examples below, right-click the tab of the Project window and select Two Column
Layout if it is not selected already. The folders of your project appear in the left column, and the contents of the selected
folder appear in the right column.

2. Right-click the Assets folder in the Project window and select Create > Material.

Assets

Create

Show in Explorer
Open

Delete

Rename

Copy Path

Import New Asset...
Import Package

Export Package...

Find References In Scene

Select Dependencies

Refresh

Reimport

Reimport All

Extract From Prefab

Run API Updater,

Update UlElements Schema

Open C# Project

Alt=Crrl+C

Ctrl+R

Folder

C# Script

Shader

Testing

Playables

Assembly Definition
Assembly Definition Reference

TextMeshPro

Scene

Prefab Variant
Audio Mixer

Matenal

Lens Flare

Render Texture
Lightmap Parameters
Custom Render Texture
Sprite Atlas

Sprites

Animator Controller
Animation

Animator Override Controller
Avatar Mask

Timeline

Cinnal

3. Rename the new Material as BrickMaterial. The preview of the new
Material is a 3D sphere, so that you can see how light interacts with
the Material at many angles. When you select the Material in the
Project window, a more accurate preview appears in a resizable pane
of the Inspector.

Assets

Scenes ErickMaterial

I Assets —e



4. Download the file Herringbone Brick baseColor.png.

5. To import the file into the project, you can simply move the downloaded file to the Assets folder for this Unity project, which
is represented in the Project window. To see the contents of the Assets folder in your file explorer, right-click the Assets folder
and select Show in Explorer.

Create >
Show in Explorer

Open

Delete

Rename

Copy Path Alt=Ctrl+C
Open Scene Additive

View in Package Manager

Import New Asset...

Import Package >

Export Package...
Find References In ne

Select Dependencies

Assets Refresh Ctrl+R

Reimport

Reimport All
Extract From Prefak

Run AP| Updater..

Scenes BrickMaterial

Update UlElements Schema

Open C# Project

6. In your computer’s file explorer, move the Herringbone_Brick baseColor.png file into your Assets folder. When you return to
Unity, you will see its icon.

Assets

Scenes BrickMaterial

Herringbone_Bric...

B Assets —0



https://connect-prd-cdn.unity.com/20201001/26e9117a-554a-406c-824e-a4fa4e649738/Herringbone_Brick_baseColor.png

4.Create the Brick Material

1. Select the BrickMaterial.

2. In the Inspector window, select the circle icon next to the Albedo property. Albedo encompasses the reflective properties of the
Material, based on a solid color or an image.

3. Select Herringbone_Brick_baseColor from the list of images in your project.

The image is now applied to the material as the Albedo map, and will appear in the Material preview.

Assets

Scenes

4. Create a new cube GameObject in the Scene.

5. Drag the material onto the cube in the Scene view.

6. The cube now displays the brick Material.

. BrickMaterial L2
v Shader Standard v
7. To change the scale of the Material, select
. . . Rendering Mode Opaque -
the cube, open the BrickMaterial Component in Main Maps
the Inspector, and change the Tiling X and Y Ml oAibeso Ca
. . ©Metallic 0
properties. Smaller numbers make the bricks s . o
appear larger. Source  Metallic Alpha v
©Normal Map
9O Height Map
©0cclusion
©Detail Mask
Tiling X1 Y1

Offset X 0 Y 0



5.Adding a Physic Material

Earlier, you added a Rigidbody component to a GameObject to give it physical properties. You can also add additional physical
characteristics with another type of Material called Physic Materials. With Physic Materials, you can make an object bounce and
change its friction and drag properties. These properties take effect when the object is under the effects of gravity. Physic Materials
don’t change the visual properties of the GameObject’s mesh.

1. In the Project window, create a new folder called Materials. Right-Click in the Materials folder in the Assets window and select

Create > Physic Material.

2. Rename the material to BouncyBall.

© Inspector | 3 Navigation

3. Select the new Physic Material.
4. Change the Bounciness value to 1 in the Inspector window.

ai
G

& BouncyBall

Open
Dynamic Friction 0.6
Static Friction 0.6
Bounciness [ |
Friction Combine Average -
Bounce Combine Average -

(= igid ]
Search
5. Select the cube. In the Inspector window, select Add Component and add a RigidBody component. & rigabooy 20

New script

6. Your cube should already have a Box Collider component added to it. This component is
automatically added when you create the cube in the scene. Drag the new Bounce physics material
you created earlier into the Material slot in the Box Collider component.

7. Run the game. Your cube should now fall to the
platform and have a bit of bounce when it hits the
floor.

8. Experiment with your bouncy cube: try rotating it,
duplicating it, and making cubes fall on top of each
other!

Assets > Materials

>

¥ @ - Box Collider

S

BouncyBall BrickMaterial

Edit Collider iay
Is Trigger
None (Physic Material) @®
Center X0 Y0 Z0
Size X1 Y1 Z1
[ Ry -

. BrickMaterial
> Shader Standard

Add Component



6.Adjusting the Lighting in the scene

In a new 3D Scene, an object named Directional Light is T D -
included to simulate sunlight. You can manipulate this light '@t%amlezcehe‘ =
with transform tools like any other GameObject.
71 ScriptObject
Ff Cube
1. Select the Directional Light in the Hierarchy window.

2. Change the rotation of the light using the transform tools Move
(shortcut key “w”) and Rotate (shortcut key “e”). Directional lights
simulate a light source that bathes the entire scene in light coming
from a specific direction. Changing the position of the light will not
have an influence on the scene but changing the rotation will change
the angle of the light in the Scene. Take note of how the sky and
ambient light changes as you change the angle of the light.

Directional light is just one type of light. If you are interested in other types, see Types of light.



https://docs.unity3d.com/Manual/Lighting.html

Manage GameObjects with prefabs

In this tutorial, you’ll use prefabs to design, create, and organize many GameObjects in a scene. By the end
of this tutorial, you will be able to:

* Explain how to use prefabs in a scene.

* Add a prefab to a project.

* Edit a prefab in prefab mode.

* Create a prefab variant.

* Apply or revert changes to a prefab variant.

* Nest prefabs.

* Describe the process and outcomes for changing a nested prefab or prefab variant.

A prefab is an asset that acts as a template of a GameObject. From the prefab, you can create
multiple copies, called instances. A change to the prefab asset causes all of its instances to change
as well. To change many trees into cacti, you could just change a single prefab tree!



2.Create a prefab

To make your scene more fun, use prefabs to make many more falling bouncy
balls. First, make a prefab to serve as your prototype bouncy ball:

1. Rename your original falling sphere GameObject to “BouncyBall”.

2. Make sure BouncyBall has a regular material and a Physic material. Adjust
the size, too, if you like. You are about to create many copies of this sphere.

3. As you did with materials, make a folder for prefabs. In the Project window,
select the Assets folder and right-click to select Create > Folder.

4. Rename the new folder to “Prefabs”.

5. Open the folder so that the right pane of the Project window (in a Two
Column Layout) shows the empty folder, where you’ll see the message “This
folder is empty”.

6. From the Hierarchy window, drag BouncyBall into the Prefabs folder. The
new asset in your Prefabs folder with the blue cube icon is your prefab.

Note: Any folder in your project can contain prefabs, not just the Prefabs
folder. However, using a Prefabs folder is good practice.

In the Hierarchy, the BouncyBall GameObject is now also blue to let you know
that this object is an instance of your prefab.

= Hierarchy
+ -
€ SampleSceneB*

) Main Camera

B Project B Cconsole
+ -
* Favorites Assets > Prefabs

L All Materials

Al Mo

QL All Prefabs

@ Assets

B Scene

I» Packages




3.Create prefab instances

With your prefab created, it’s easy to make a lot of bouncy balls to fall onto your structure:
1. From the Prefabs folder in the Project window, drag the BouncyBall prefab into your scene.
2. Drag several more instances into your scene, up to 10.

3. Position the new BouncyBall instances so that they will fall on your structure. For more bounce, position them higher (increase
Position Y)!

Tip: Hold down Shift in either the Scene view or the Hierarchy to select all your new instances at once, then position them as a
group.

4. Run your application and watch the spheres fall and bounce!



4.Update prefab instances in prefab mode

What if, for example, you wanted all your BouncyBall instances to be a different color? You can update the color all at once by updating
your prefab in prefab mode, a special editing state in which you can change a prefab in the Scene window.
To enter prefab mode and edit your prefab:

= Hierarchy

1. In the Hierarchy, select a prefab instance and then select the arrow on the right side of the row.

Tip: By default, prefab mode appears in the context of your scene. To edit your prefab in
isolation, press Alt while selecting the arrow.

In prefab mode, the prefab is the only GameObject you can edit. z

2. In the Project window, open your Materials folder and drag a different material onto the prefab in
the Scene window. Select a material that will be noticeably different.

3. Select Save near the top right of the Scene window to save your changes. (If you skip this step,
you’ll be prompted to save when you exit prefab mode.) You can also enable Auto Save to save your
edits as soon as you make them.

4. To exit prefab mode, select the arrow at the top left of the Hierarchy window.

‘= Hierarchy
+ v ao

ﬁBuuncyBaIl
3 ff BouncyBall

All your BouncyBall instances will have the new material!

This is a simple example, but prefabs are quite powerful. Consider these examples:

In a model of a city, there are 100 parking meters. You can change the text on every parking meter at
once.

In a prototype of a game, a colleague is modeling the enemy character while you work on gameplay.
Your placeholder for the enemy is a prefab of a capsule primitive. When the enemy is ready to import,
you can simply replace the capsule object in the prefab with the new model.




5.0verride prefab properties

When you make a change to a property of one prefab instance, that property is called an override, since you are overriding the default
prefab settings. The Inspector window helps you keep track of your overrides. @ Inspector i

To make variations in your prefab instances with overrides:

ab Open Select

1. In the Scene view, select one of your BouncyBall prefab instances.
While this object is selected, take a look at the top of the Inspector window. There is an additional section titled Prefab containing

controls that you can use to work with the prefab. (The Open button is another way to edit the prefab in prefab mode.)

-]

2. Using the Transform component in the Inspector, change the Scale on the K - —
X, y and z-axes of this BouncyBall. Make the change noticeable in the Scene h
window.

The blue line in the left margin of the Inspector indicates that the Scale ——— >
property varies from the base prefab.

Position

Rotation

e T e |

Scale

3. Using the Sphere Collider component in the Inspector, select the
circle icon to change the Physic material to None. Now it will not

bounce when it hits the ground. ateria None (Physic Material)
4. Apply a different material to this GameObject so that it looks visibly o — i =

different from the others

HH « Mesh Renderer

Materials

Element O * SolidRed




5. Run the application. Notice that the only sphere that doesn’t bounce and has a Overrides to §§ BouncyBall
different material is the one you edited. If you want to apply those changes to all in €} Scene
instances of this prefab, you’ll need to apply them to the base prefab.

You have now overridden three properties: the Scale, Physic material, and regular
material. In the following steps you’ll do something different with each one.

i@ BouncyBall (2)

dnNslormm

6. Using the Prefab controls at the top of the Inspector, select Overrides to see a list
of components that differ from the prefab.

7. Let’s say that you have changed your mind about removing the
Bouncy Physic material. Select the Sphere Collider component from
the Overrides list to view two versions of the component: Prefab
Source and Override.

Apply AR

None (Physic Material) G

8. To return the Sphere Collider back to the original settings, select
Revert at the top of the Override version of the component. This ball
will change back to use the Bouncy Physic material.

9. Let’s say that you want all your bouncy balls to be as large as this
one. To apply the override in the Transform component to the base
prefab, return to the Overrides dropdown and select Transform >
Apply > Apply to Prefab “BouncyBall”. All of the balls will change size!

Revvert All Apply All

Overrides are useful if you want to make variations to your prefabs one at a time or test
a change before you apply it to multiple GameObijects. In the next step, you’ll see how
to organize different variations of your prefabs.



6.Create prefab variants

You can create networks of variations using prefab variants, which are prefabs based on other prefabs.
Prefab variants make it much easier to create a series of interrelated prefabs that will give your project a uniform look. For example, in a
project with many trees, you could create a base prefab of a tree and then create apple tree and peach tree variants of that prefab.

When you make changes to the base tree prefab, they will appear on all the
apple and peach trees. When you make changes to the peach tree variant,
they will appear only on the peach trees.

To create a prefab variant of your BouncyBall: . Would you ke to create  new original Prefab or a
@ variant of this Prefab?

1. Select the BouncyBall instance you’ve been working on, which has a
different material than the others. Original Prefab Cancel

Create Prefab n

2. From the Hierarchy, drag this instance into your Prefabs folder. You’ll see a
prompt to create a new original prefab or a prefab variant.

3. Select prefab variant. (If you select Original Prefab, then changes to the
original prefab won’t propagate to the prefab variant.)

4. In the Prefabs folder in the Project window, rename your new prefab
something descriptive, like “RedBouncyBall.”

5. To create more of these new bouncy balls, drag new instances of this new
prefab into your scene and reposition them to fall on your structure.



Get 3D assets

In this tutorial, we’ll explain sources of 3D assets: assets made with Digital Content Creation (DCC) tools or
procured from the Unity Asset Store. We will walk through the steps for using the Asset Store to get assets
you will need for the tutorial following this one.

In this tutorial, you’ll be able to:

Explain the content creation tools that support real-time 3D production
Navigate to the Asset Store in a web browser

Search and filter a search in the Asset Store

Import an asset from the Asset Store automatically via a Unity account



2.What are 3D DCCs?

3D Digital Content Creation tools (DCCs) such as Maya, ZBrush, and
Blender allow artists to create environments, models, and characters in
three dimensions.

In these programs, artists model the shape of a 3D object, rig it so that it
can be animated, animate it to move in a particular way, and texture it
to give it color and shading. An example of this is shown below.

The 3D assets made in DCCs are brought into a real-time engine such as
Unity, where they are integrated into a larger project like a game,
simulation, or animated film.



https://www.autodesk.com/products/maya/overview
https://pixologic.com/
https://www.blender.org/

3.0ther resources for 3D assets in Unity

It is possible to create 3D art and environments within the Unity editor using a
tool called ProBuilder. Probuilder has limited functionality compared to
dedicated DCCs, but it is helpful for artists who want to quickly model 3D
objects without opening an external editing tool.

Not everyone has the time to learn a 3D DCC or the budget to hire someone to create 3D art for them, but there are many
online resources for obtaining high quality assets. In addition to sites like CGTrader and Turbosquid, which offer 3D models for
all purposes, the Unity Asset Store is an invaluable resource for art specifically designed with Unity in mind.



https://unity3d.com/unity/features/worldbuilding/probuilder
https://www.cgtrader.com/
https://www.turbosquid.com/
https://assetstore.unity.com/

5.Get assets from the Asset Store

You can take advantage of the talent, time, and effort it takes to create 3D assets by visiting the Unity Asset Store. The Asset
Store is a convenient platform for specialized asset creators to share or sell their work, and for real-time creators to find pre-
designed, pre-built assets that are ready to use. These assets include 3D models, Materials, animations, loading screens,
scripts, and anything else you might need for your project.

Please note that this tutorial is made in Unity version 2019. In the 2020 release of Unity, the Asset Store downloads will move
to the Package Manager, creating a slightly different process.

1. Go to the Unity Asset store (this link will open in your default browser) and log in with your Unity ID.
Hint: Anything you acquire through the Asset Store will be linked to your Unity account and will be available in the Editor as
long as you are signed in with the same Unity ID.

2. In the Asset Store search tab, type “materials” to search for available Material assets. All assets with the tag of “materials”
appear.

4. Select the Yughues Free
New to Unity? Checkout these top picks for all experie: Ground Materials (or
something similar).
€QunityAssetStore | materials x a

) materials
1=-24 of 3794 results for matd

Popularity textures materials
. @ QUICK LOOK
Pricing o
I:/'_'\ ./'_'\:I
3. Use the checkbox on the gl
right of the store screen to 50 $ 299 Yughues F‘ree Ground Materia..
view only the free assets. % % % k% (1581)

[ Free Assets ] FREE



https://assetstore.unity.com/

5. Check the Unity version of the assets you have selected. It is critical to make sure
that the assets will be compatible with your version of Unity. On the Details page,
you will see all the information about the asset, including the Unity version
compatibility.

6. Select Add to My Assets to begin the process of procuring the asset package you
have chosen. You will see a confirmation message like the one below.

Added to My Assels H : Fiisk

1. Select Go to My Assets to view your My
Assets page.

Yughues Free Ground Materials

4 Nobiax / Yughues wkkdk 5| 129 Reviews
Add to My Assets v
License Extension Asset
File size 1321 MB
Latest version 1.0
Latest release date Mar 31, 2015
Support Unity versions 4.2.2 or higher ]




6.Import assets from the Asset Store
1. Select Go to My Assets to view your My Assets page.

You can always return to the My Assets page in the Asset
Store to view the assets you have selected and purchased

2. Select the Open in Unity button for the assets you just
selected. If your computer prompts you to open the Unity
Editor, select the option to do so. The Unity Editor will
open with the My Assets section of the Package Manager
displayed, including the asset package you just selected in
the Asset Store.

MY Assets Sortby  Puschied Data view Resdts 28 Refina by
1 115 in S it
s
O
Vughrans P
Labals
[
- Fiued Adweniture rat re
ﬂ Categerios
i
. | Feoe pia 2D !
Futbshars
<+ ~ Packages: My Assets » Sort: Name | v Filters » Clear Filters o

» 2D Beginner: Tutorial Resources
» 20 Game Kit

» 30 Beginner: Tutorial Resources
» B118647-1

» Free Platform Game Assets

» Pixel Adventure 1

» Real Materials Vol.0 [FREE]

101 &
193 4
121 4

1.0 &
194 &

e

31 &

» Training Assets-Intro to Virtual Reality... ... L

» Unity Certified Programmer Exam Pre... ..

» Yughues Free Metal Materials

All 15 packages shown

Last update Oct 8, 11:17

Yughues Free Ground Materials

Nobiax / Yughues
Version 1.0.0 - March 31, 2015
View in the Asset Store « Publisher Website

18 free ground materials
1024 square textures (.tga + compressed)
Textures included:

More.
Images & Videos

» Unity Certified Programmer Exam Pre... .. &

» Unity Certified Programmer Exam Pre... ... &

B Loy PAITEIR Ok 16 L1 yjew images & videos on Asset Stare

» Yughues Free Concrete Materials 10 & package Size Supported Unity Versions
[ » Yughues Free Ground Materials 10 & ]Suz: 15.14 M8 (NNumber of files: 73) 4.2.2 or higher

118 purchased Date

October 05, 2020
Release Details

1.0 (Current) - released on March 31, 2015 More...
Original - released on November 18, 2013
Assigned Labels

(None)

Import | Downloa:



3. Select the package from the Asset Store, and select the Download button at the lower right corner. Once you have
downloaded an asset package from any project, you do not have to download it again for use in another project, and this button
will not be highlighted.

Import Download

e . I

4. When downloading is complete, select the Import button. Impart R

[ |
U Import Unity Package n
|

5. An import options panel will open. Use the checkboxes to import ,H e T
everything or only specific assets in the package. For this example, e '
select everything and select the Import button at the bottom of the | v moygouns

« [ diffuse.tga

v

| ~ Q Dry ground pattern.mat
panel. ~ B normal.1ga

~ [ preview jog
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Publish your project

Summary

Let’s see what you’ve made! In this tutorial, you’ll:
*Set the platform for a build of a Unity project
*Create a basic build of a Unity project.
*Share your project with the Unity Learn community.

When your game is ready, it is time to create a build, which is a standalone,
playable version of your game. Unity supports most popular platforms, including
mobile (Android and iOS), which allows you to quickly publish your project with a
few simple clicks.

Keep in mind that while it is easy to publish to different platforms, it is up to you,
the game developer, to make sure that your game can run on the target
platforms. For example, the resources available on a smartphone are vastly
different than those on a Playstation. Just because you can build for a platform,
your game will not necessarily run on that platform.

In this tutorial, you will publish to WebGL (HTML5) so that you can share your
project on the web with the Foundations community, if you like. The build process
is the same for publishing to any other platform such as Windows, Linux or MacOS.



